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Warranty

 

Maxtor’s warranty obligations are limited to the terms set forth: Maxtor warrants 
only to the original consumer purchaser that new Maxtor products will be free 
from defects in material and workmanship for 1 year from the date of original 
purchase.

For a replacement product, the warranty on the replacement device is the 
remainder of the warranty on the original device or 90 days, whichever is longer. 
If you discover a defect, Maxtor will, at its option, repair or replace the product at 
no charge to you, provided you return it during the warranty period, with 
transportation charges prepaid, to Maxtor in Ireland, Singapore or the USA.

Products must be properly packaged in Maxtor packaging or Maxtor approved 
packaging to obtain warranty service. Before returning a Maxtor product, please 
contact Maxtor at: +353 1 204 1111 (in Europe) or 1-800-2MAXTOR (in U.S.) to 
obtain a Return Material Authorization (RMA) number. A copy of the receipt or a 
bill of sale bearing the appropriate Maxtor serial number and model number may 
be required for warranty service. The warranty applies only to the Maxtor 
products that can be identified by the Maxtor trademark, trade name, serial 
number or logo affixed to them. Maxtor does not warrant any product that is not 
manufactured by, for or with permission from Maxtor.

This warranty is not applicable to: Abnormal wear and tear; Abuse, unreasonable 
use, mistreatment, or neglect; Damage caused during installation of the Product; 
Damage caused by the equipment or system with which the product is used; 
Damage caused by modification or repair not made or authorized by Maxtor; 
Product whose Maxtor Serial Number has been removed or defaced; Damage 
caused by liquids in the product case; Damage to the products’ interface or 
power connectors; Damage caused by use of non-Maxtor packaging; Damage 
caused by improper or improperly used packaging; Products that are determined 
to be stolen.

THIS WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND 
IN LIEU OF ALL OTHERS, WHETHER ORAL OR WRITTEN, EXPRESSED OR 
IMPLIED. MAXTOR SPECIFICALLY DISCLAIMS ANY AND ALL IMPLIED 
WARRANTIES, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND 
AGAINST INFRINGEMENT.

Additionally, Maxtor does not warrant that the installation software for Macintosh 
OS and Windows OS will meet your requirements nor the performance or results 
that the operation of the program will be uninterrupted or error free. No Maxtor 
dealer, agent or employee is authorized to make any modification, extension or 
addition to this warranty.

MAXTOR IS NOT RESPONSIBLE FOR SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES RESULTING FROM ANY BREACH OF 
WARRANTY, OR UNDER ANY OTHER LEGAL THEORY, INCLUDING BUT NOT 
LIMITED TO LOSS OF DATA, LOSS OF PROFITS, DOWNTIME, GOODWILL, 
DAMAGE OR REPLACEMENT OF EQUIPMENT AND PROPERTY, AND ANY 
COSTS OF RECOVERING, PROGRAMMING OR REPRODUCING ANY 
PROGRAM OR DATA STORED IN OR USED WITH MAXTOR DISK DRIVES OR 
MAXTOR PRODUCTS CONTAINING MAXTOR DISK DRIVES or any software 
product distributed therewith.

Some states/jurisdictions do not allow the exclusion or limitation of incidental or 
consequential damages or exclusions of implied warranties, so the above 
limitations or exclusions may not apply to you. This warranty gives you specific 
legal rights, and you may also have other rights that vary from jurisdiction to 
jurisdiction.

Changes are periodically made to the information herein – which will be 
incorporated in revised editions of the publication. Maxtor may make changes or 
improvements in the product(s) described in this publication at any time and 
without notice. This product tested to comply with FCC standards for home or 
office use.
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Before You Start

Thank you for selecting a Maxtor product.Your Maxtor OneTouch 

drive is an external hard drive that allows you to add storage to your 
computer to hold and organize your documents, videos, music, 
photos, graphics, and more. 

You can also use your new drive to make copies of critical files
as a part of your overall backup solution. By using the Maxtor
OneTouch feature, your drive can create and store a copy
of your important files with a touch of a button. 

Whether you use the drive for additional storage, to create a copy 
of your files, or both, this guide will get you up and running and
provide helpful tips for using your drive. 

The Maxtor OneTouch drive has the following features:

• Large capacity
• Mac OS Extended format
• Maxtor OneTouch feature: the easy way to make

a backup copy of your files
• Plug and Play installation
• High-speed performance
• FireWire®

• Stacks and stands upright to fit on your desk
• Expandable so you can connect up to 63 drives via FireWire. 
• Hot-swappable to move the drive between computers
• Power Management features to conserve energy when your 

drive isn’t being used
• Compatible with security locking cables, including

those offered by Kensington®

1
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OneTouch Drive Components
Before installing your new drive, review the features shown below.
in Figure 1.

Figure 1.  OneTouch Drive Features

Included in this Kit

The Maxtor OneTouch drive comes complete with the components 
shown in Figure 2. Familiarize yourself with each of these items 
prior to installation.

FireWire Ports

Status Light
Flashing Blue 

Lights

Maxtor
OneTouch

Button

Security 
Locking Slot

Front Back

Power 
Connector

Power
Switch

User’s Guide

Vertical StandInstall CD

Rubber Feet

Maxtor OneTouch Drive

Power adapter

FireWire Cable

6-pin to 6-pin FireWire 
cable for connecting 
your Maxtor drive to 

your computer.
2 

Figure 2.  Included in this Kit

(See “Adding Rubber Feet to Your OneTouch 
Drive” on page 22 in chapter 3, for

installation instructions)
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System Requirements
The following are the minimum system requirements. 

Macintosh

• Mac OS 9.1 or higher or Mac OS X versions 10.1.2 - 10.1.5
and versions 10.2.4 or higher

• CD-ROM drive
• 64 MB RAM or more as required by Mac OS
• FireWire 
• Internet connection (for system updates)

Handling Precautions 
Handle your drive with care! Follow the precautions listed here
or damage to the drive may result and your warranty may become 
void. Review the “Maxtor Product Warranty” on the inside front 
cover for more information.

The following precautions can prevent loss of data:

• Do not bump, jar, drop the drive or move while in operation.
• Do not stack drives more than two high.
• Do not set the drive on its side without using the vertical 

stand as it may fall over and cause damage.
• Do not remove any cables or power cords without properly 

disconnecting the drive through the operating system. 
• Do not set any liquids or drinks on the drive. Liquids will 

damage the internal electronics.
• Do not attempt to open the drive’s case. This will void

your warranty.
Before You Start 3
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About this Guide
The following symbols and conventions are used in this guide:

Where to Go for Help
For additional help with your drive, its installation and the
software, contact one of the following:

Maxtor Support

Maxtor provides a comprehensive product support section
on its web site, including the latest drivers, user guides, and
the Knowledge Base at http://www.maxtorkb.com (answers to 
common questions and problems). 

For support in Europe and the Middle East, go to:

If you do not have Internet access, you can call: 

1-800-2-MAXTOR (in the United States)

+1 303 678 2015 (Outside the continental United States)

Dantz Support

Contact Dantz® Development Corporation for help with
Retrospect® software, making backup copies with Maxtor
OneTouch, or restoring files. Dantz provides free telephone support 
for the first 30 days and a comprehensive support section on its 
web site, including the latest software downloads, Knowledge 
Base (answers to common questions and problems), hardware 
compatibility and contact information.

On the Web: http://www.dantz.com 

Select the link labeled Support & Hardware.

Check the Dantz web site for additional support phone numbers 
outside the USA.

If you do not have Internet access, you can call: 

1-888-777-5664 (in the United States)

+1 925 253 3050 (Outside the continental United States)

Bold Used for menu, command, and keyboard
selections you make and screens you will see.

Italics Used for emphasis and to identify new terms,
which may also be defined in the Glossary.

Helpful information about a particular topic.

Important information to prevent problems and
ensure that you are successful in using the drive.
4 

http://www.maxtorsupport.com

Check the Maxtor support web site under Contact Us for
additional support phone numbers outside the USA.

For technical support in Asia Pacific regions, please e-mail to 
ApacTech_Assistance@Maxtor.com
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Installing Your Drive

This chapter describes how to install the Maxtor OneTouch™ drive, 
the Dantz Retrospect backup software, and how to activate the 
Maxtor OneTouch button for simplified backups of your valuable 
data anytime you need them. To ensure a successful installation, 
follow the steps outlined below.

Please do not connect the drive to your computer until 
after you have installed the software.

Follow these steps to install your drive

Step 1. Install the software.
Step 2. Connect the drive to your computer. 

Step 3. Set up the Maxtor OneTouch button.

Software Installation Options

There are two options for the software installation:

• Full Installation (Recommended) 

Select your operating system
The complete, step-by-step installation for popular Macintosh 
operating systems is described separately in the following sections. 
Simply find the section for your operating system and follow the 
steps to get your OneTouch drive up and running.

• Macintosh OS X: See below

• Macintosh OS 9: See “Macintosh OS 9: Installing the 
Software” on page 9

Macintosh OS X: Installing the Software
1. Turn on your computer

2. Insert the Maxtor Installation CD into your CD-ROM drive. 

After a few seconds, the Install CD should appear on your 
Macintosh’s desktop.

2

Installing Your Drive 5

Installs the Maxtor software drivers necessary for the 
OneTouch drive to operate, the OneTouch Utility program and 
the Dantz Retrospect backup software that allows you to 
backup data at the touch of a button.

• Custom Installation
Installs ONLY Maxtor drivers and OneTouch Utility program. 

3. Open the Install CD Icon.

4. Find the folder appropriate for your language and open it.

5. Double-click the Install Retrospect Express icon.

The Authenticate window will open.
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6. Enter your Name and Password for your OS X system.

(This is the Name and Password you set up when you originally 
installed OS X)

Click OK.

The Retrospect Express Installer will open.

7. Click Continue.

The license screen will appear. 

8. Review license agreement and Accept to continue.

The Install Retrospect Express screen will appear.

9. This screen allows you to specify what type of installation you 
want and where. It is automatically setup to do a Full 
Installation (Recommended) into the Applications folder on 
your Macintosh.

You can select a Custom Installation, using the Easy Install 
menu, as well as change the location of the installation using 
the Install Location menu at the bottom of the screen.

When you are ready, Click Install.

12. After your Macintosh restarts, please remove the Maxtor 
Install CD from your computer.

13. Proceed to the next section: Connecting the Drive.

Macintosh OS X: Connecting the Drive
The Maxtor OneTouch Drive connects to your computer using the 
FireWire interface. 

Please install the software BEFORE you connect the drive.

Connecting the Power

1. Plug the round female connector from the power adapter into 
the drive’s power connector.

2. Plug the two-pin female connector on the power cord
into the power adapter.
6

The installation will begin.

10. When the installation is complete, the Installation was 
successful screen should appear, asking you to Restart.

11. Click Restart. 

Figure 3.  Connecting the Power 

3. Plug the standard electrical plug from the power adapter into 
your power source.

4. Turn on the Maxtor OneTouch Drive using the power switch on 
the back of the drive. The two blue lights on the front of the 
drive should illuminate.
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Connecting with the FireWire Cable

This section describes how to connect your OneTouch drive using a 
FireWire cable. For more information about the FireWire interface, 
go to http://www.askfor1394.com.

To connect the FireWire cable

1. Plug one end of the FireWire cable into any available FireWire 
port on your computer or to any other FireWire device that is 
connected to your computer.

2. Plug the other end of the FireWire cable into an available 
FireWire port on the back of the drive. 

Figure 4.  Connecting to a FireWire port

3. After a short time, your drive should appear on the desktop of 
your Macintosh.

Macintosh OS X: Setting Up the 
Maxtor OneTouch Feature
Once the drive is recognized by your computer, you can set up the 
Maxtor OneTouch feature to automatically make a backup copy of 
your selected files each time you press the OneTouch button.

Before you begin, make sure the Maxtor Install CD is NOT 
in your CD-ROM drive. 

To set up the Maxtor OneTouch button feature

1. Push the button on the front of your drive. 

A window appears that says: ‘You need an administrator 
password to start Retrospect’

Enter your Name and Password for your OS X system.

(This is the Name and Password you set up when you originally 
installed OS X)

2. Click OK.

The next screen will appear: 

‘Would you like to register Retrospect Express now?’

3. Choose Register Now, Register Later or Already Registered.

FireWire 
Ports

FireWire Ports
Installing Your Drive 7

The installation is complete and your Maxtor OneTouch drive is 
ready to use!

If you did the Full Installation, including Retrospect Express, we 
encourage you to go to the next section to set up the Maxtor One-
Touch feature for easy, automated backup of your important files, 
anytime, at the touch of a button! 

If you chose Register Now, go to the next step. 
If you chose Register Later or Already Registered, 
Retrospect Express will open. Go directly to Step 5.

4. Enter the required information on the form. 

• Click Email to register via email
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• Click Print to register via mail

• Click Register Later if you do not want to register at this time.

By registering1 your new drive, you will have the option of 
receiving product updates, special offers, and important 
information about other data storage solutions from Maxtor.

Once you’ve made your selection, Retrospect Express will 
open and the Maxtor OneTouch Setup screen will appear.

5. Click Next.

The Step 1 screen will appear.
 

6. Select the drive to copy your files from and click Next.

The Step 2 screen will appear.

7. Choose the type of files to copy: 

Just Documents copies only documents you have created, 
including your favorite files, bookmarks, and cookies. This 
selection is ideal for most users. 1. Your registration information is collected and maintained according to 

the Dantz and Maxtor privacy policies located on their respective 
8

Applications and Documents copies application files in 
addition to documents. This selection allows you to restore an 
application file if it has become damaged. Refer to the Express 
User’s Guide for instructions on how to make
a complete system backup copy.

web sites. 

If you choose to E-mail the information, make sure you are 
connected to the Internet.

If you choose to print the information, you can fax the form to Dantz 
Corporation at +1 925 253 9099.
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This selection does not copy your operating system files or 
Internet cache files.

If you want to create a full backup of your entire system, go to 
‘Chapter 4: Backing up your system.’

8. Make your choice and click Next. 

9. The Step 3 screen is displayed. Select the Maxtor OneTouch 
drive or another drive on your computer as the location to store 
the copy of your files. Click Next.

You cannot select the same drive to be both the source and 
destination for your files. The source and destination drives 
must be different.

The “Congratulations... now ready” screen appears. 

10. To complete the Maxtor OneTouch setup, click Finish. 

11. Go to the Retrospect Express menu and choose Quit 
Retrospect Express to exit Retrospect Express. 

You are now ready to use the Maxtor OneTouch feature. 

Each time you touch the button, Retrospect Express makes a copy 
of the folders and files on your source drive exactly as
they exist at that time.

The OneTouch button may not function when Retrospect 
Express is already running. To correct the problem, quit 

Express to make copies of your important files and restore copied 
files.

Macintosh OS 9: Installing the Software
1. Turn on your computer

2. Insert the Maxtor Installation CD into your CD-ROM drive. 

After a few seconds, the Maxtor CD should appear on your 
Macintosh’s desktop.

3. Open the Install CD icon.

4. Find the folder appropriate for your language and open it.

5. Double-click the Install Retrospect Express icon.

The Retrospect Installer will open.

6. Click Continue.

The license screen will appear.

7. Review the license agreement and click Accept if you agree.

The Install Retrospect Express screen will appear.

This screen allows you to specify what type of installation you 
want and where. It is automatically setup to do an Easy Install 
Installing Your Drive 9

Retrospect Express.

Your install is now complete. Push the OneTouch button, if you 
would like, to begin your backup.

See “Using Your Drive” on page 15 in chapter 3, for information on 
using your drive for common applications and on using Retrospect 

(full installation) which is recommended. It will install 
Retrospect Express into the Applications folder on your 
Macintosh.

You can select a Custom Installation, using the Easy Install 
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pop-up menu, as well as change the location of the installation 
using the Install Location menu at the bottom of the screen.

8. When you are ready, click Install.

The installation will begin.

When the installation finishes, the Installation was successful 
window should appear, asking you to Restart.

9. Click Restart.

10. After your Macintosh restarts, please eject the Maxtor Install 
CD from your computer.

11. Proceed to the next section: Connecting the Drive.

Macintosh OS 9: Connecting the Drive

The Maxtor OneTouch Drive connects to your computer using the 
FireWire interface. 

Please install the software BEFORE you connect the drive.

Connecting the Power

1. Plug the round female connector from the power adapter into 
the drive’s power connector.

2. Plug the two-pin female connector on the power cord
into the power adapter. 

Figure 5.  Connecting the Power

3. Plug the standard electrical plug from the power adapter into 
your power source.

4. Turn on the Maxtor OneTouch Drive using the power switch on 
the back of the drive. The two blue lights on the front of the 
drive should illuminate.

Connecting with the FireWire Cable

This section describes how to connect your OneTouch drive using a 
FireWire cable. For more information about the FireWire interface, 
go to http://www.askfor1394.com.

To connect the FireWire Cable

1. Plug one end of the FireWire cable into any available FireWire 
10

port on your computer or any other FireWire device that is 
connected to your computer.
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2. Plug the other end of the FireWire cable into either of the 
available FireWire ports on the back of the drive. 

Figure 6.  Connecting to a FireWire port

3. After a short time, your new drive will appear on the desktop of 
your Macintosh.

The installation is complete and your Maxtor OneTouch drive is 
ready to use!

If you did the Full Installation, including Retrospect Express, we 
encourage you to proceed to the next section to set up the Maxtor 
OneTouch feature for easy, automated backup of your important 
files, anytime, at the touch of a button!

Macintosh OS 9: Setting Up the 
Maxtor OneTouch Feature

To set up the Maxtor OneTouch button feature

1. Push the button on the front of your drive. 

A window should appear: ‘Would you like to register 
Retrospect Express now?’

2. Choose either Register Now, Register Later or 
Already Registered.

If you choose Register Now, go to the next step. 

If you chose Register Later or Already Registered, 
Retrospect Express will open. Go directly to Step 4 - 
Maxtor OneTouch Setup.

3. Enter the required information on the form. 

• Click Email to register via email

• Click Print to register via mail

• Click Register Later if you do not want to register at this time.

By registering1 your new drive, you will have the option of 
receiving product updates, special offers, and important 

FireWire 
Ports

FireWire Ports

1. Your registration information is collected and maintained according to 
the Dantz and Maxtor privacy policies located on their respective 
Installing Your Drive 11

Once the drive is recognized by your computer, you can set up the 
Maxtor OneTouch feature to automatically make a backup copy of 
your selected files each time you press the OneTouch button.

Before you begin, make sure the Maxtor Install CD is NOT 
in your CD-ROM drive. 

web sites. 

If you choose to E-mail the information, make sure you are 
connected to the Internet.

If you choose to print the information, you can fax the form to Dantz 
Corporation at +1 925 253 9099.
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information about other data storage solutions from Maxtor.

4. Retrospect Express will open and the Maxtor OneTouch 
Setup screen will appear. 

Click Next. 

The Step 1 Screen will appear.

5. Select the drive to copy your files from and click Next.

The Step 2 screen will appear.

6. Choose the type of files to copy: 

application file if it has become damaged. Refer to the 
Retrospect User’s Guide for instructions on how to make
a complete system backup copy.

This selection does not copy your operating system files or 
Internet cache files. If you want to create a full backup of 
your entire system, go to “Backing up your complete 
system” on page 25 in chapter 4.

Make your choice and click Next. 

7. The Step 3 screen is displayed. Select the Maxtor OneTouch 
drive or another drive on your computer as the location to store 
the copy of your files. Click Next.

You cannot select the same drive to be both the source and 
destination for your files. The source and destination drives 
must be different.

The “Congratulations...now ready” screen appears. 

8. To complete the Maxtor OneTouch setup, click Finish. 

9. Go to the File menu and choose Quit to exit 
Retrospect Express. 

You are now ready to use the Maxtor OneTouch feature!

Each time you touch the button, Retrospect Express makes a copy 
of the folders and files on your source drive exactly as they exist at 
12

Just Documents copies only documents you have created 
including your favorite files, bookmarks, and cookies. This 
selection is ideal for most users. 

Applications and Documents copies application files in 
addition to documents. This selection allows you to restore an 

that time. 
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Depending on the amount of files, your first time backup, 
may take a long time. 

The OneTouch button may not function when Retrospect 
Express is already running. To correct the problem, go to 
the File menu in Retrospect, and choose Quit.

See “Using Your Drive” on page 15 in chapter 3, for information on 
using your drive for common applications and on using Retrospect 
Express to make copies of your important files and restore copied 
files.

The drive will not operate with more than one computer
at a time.

Maxtor does not support using the drive as a startup
disk for the Macintosh.

Using your OneTouch button for backup

Only the current versions of your files are saved. Backup 
copies made with the default Maxtor OneTouch feature do 
not include earlier versions of files you have deleted since 
the last time you pressed the Maxtor OneTouch button.
Any files that are currently open are not saved, so close any 
files you wish to be copied.
You may customize Retrospect to create backup copies of 

Installing Drivers Only
No drivers are necessary. This section describes how to install your 
new drive without installing Retrospect Express software.

The Maxtor OneTouch button feature will not function if you 
choose to install under this option.

If you’re using OS 9, connect your OneTouch drive as described in 
“Macintosh OS 9: Connecting the Drive” on page 10. If you’re 
using OS X, connect your drive as described in “Macintosh OS X: 
Connecting the Drive” on page 6.
Installing Your Drive 13

your files which will include revisions made on a daily basis.
See the Express User’s Guide, included on the install CD.

Your hardware and software installation is now complete. See 
“Using Your Drive” on page 15 in chapter 3, for information on 
using your drive for common applications and on using Retrospect 
to make copies of your important files and restore copied files.



2

To Install Retrospect at a Later Time

If you wish to install a complete copy of Retrospect software and 
the Maxtor OneTouch feature at a later time, you can do so by fol-
lowing the original installation instructions provided in the “Setting 
Up the Maxtor OneTouch Feature” detailed earlier in this chapter 
for each operating system.
14
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Using Your Drive

Once installed, you can use your new Maxtor OneTouch drive in the 
same way you use the other drives on your computer. Some of the 
basic ways you can use your new drive are:

• Move or copy files or folders from your other drives, CD-
ROMs, or other storage devices.

• Within virtually any application, save files to and open files 
from the new drive.

• Store video files, games, spreadsheets, and other commonly 
used files.

• Store copies of important files from your desktop or laptop 
computer.

This chapter offers additional suggestions on how to use your new 
drive.

OneTouch Drive lights and their messages
The blue lights on the front of your drive provide useful information.

Connecting and Disconnecting the Drive
The FireWire interface allows you to hot swap your new Maxtor 
OneTouch Drive; that is, connect and disconnect the drive while the 
computer and your drive are running.

To connect the drive

1. Make sure the drive is turned on and that both blue lights 
are illuminated. 

Connecting your computer to a drive that is not powered on 
can cause your computer to behave erratically or freeze.

2. Plug the FireWire cable into the drive and your computer. 

After a moment, the computer will recognize that your 
drive is connected and the drive icon will appear on the 
desktop of your Macintosh.

To disconnect the drive

1. From the desktop, drag the drive icon to the Trash. 

3

Table 1: OneTouch lights
Using Your Drive 15

The drive will disappear from the desktop.

2. Disconnect your drive from the computer.

Message Status

Both lights on Power on/ready to go

Alternating blinking Processing command/transferring data

One off and one blinking Power saving mode
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What is Maxtor OneTouch?
Maxtor OneTouch is an easy way to make backup copies of your 
files. By pressing the button on the front of your drive, your files are 
copied. It’s that simple.

How does the Maxtor OneTouch drive work?

Each time you touch the button, the Maxtor OneTouch drive opens 
up Dantz Retrospect Express and makes a copy of the files on your 
source drive, exactly as they exist. 

Here are some important guidelines:

• Only the current versions of your files are copied. The Maxtor 
OneTouch drive does not keep backup copies made in 
earlier sessions.

• If you delete files from your source drive and then push the 
button, those same files will also be deleted from your Maxtor 
OneTouch drive.

• Any files that are currently open will not be copied to the 
Maxtor OneTouch drive. Close any files you want copied before 
pressing the button.

Can I customize the Maxtor OneTouch Backup?

Yes. Using Retrospect Express, you can customize OneTouch 
backup in a variety of ways. The default type is a duplicate backup 

will erase all files on the destination drive’s backup folder and will 
only copy the selected files from the source drive’s folder. 
Use with caution! 

It is strongly recommended that you: 

• Select the option to “Replace Corresponding Files” 
(see Figure 7) 

• Define a folder on the destination drive dedicated to your 
duplicate backups.

Figure 7.  
16

(outlined in”How does the Maxtor OneTouch drive work?” above). 
You can even customize how the duplicate replaces files on the 
destination drive.

If you modify the destination location for the Maxtor OneTouch 
script or any other duplicate script in Retrospect, it will default to 
“replace the entire contents” of the selected drive or folder. This 
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Archiving files

Archive is another type of backup you can do with Retrospect 
Express. Note that using this function will permanently remove files 
from the source drive and place them on the destination drive. If 
your destination drive is lost or damaged, you will have lost your 
only copy of these files.

Can I do other types of backup?

Yes. Using Retrospect Express, you can also create a script to back 
up multiple revisions of each file or to back up multiple drives or 
folders to a single backup set. This is the second type of backup 
you can create and customize. To access files contained in the 
backup set, use the Retrospect software.

More Information

To learn more about creating a backup script, go to 
www.maxtorkb.com and enter “OneTouch” in the search function. 
Refer to the Express User’s Guide for detailed information about 
creating custom scripts and backup sets.

Using Retrospect
Your Maxtor OneTouch drive includes a full copy of the Dantz 
Retrospect Express software. It includes many powerful and 
convenient features. In addition to enabling the Maxtor OneTouch 

• Recover lost work easily – restore a single file or the contents 
of an entire drive in one easy step.

• Save time and minimize storage space needs.

If you installed your drive with the Maxtor OneTouch feature, the 
Retrospect Express software is already installed. 

Retrospect User guide

Use the Express User’s Guide in the Retrospect Express Folder on 
your Macintosh. If it is not installed on your computer, you can 
access it on the Maxtor installation CD. 

Retrospect Express User’s Guide on the CD:

1. Insert the Maxtor Installation CD into your CD-ROM 
drive.

The Install CD icon will appear on your desktop.

2. Double-click the CD icon to open it.

3. Open the folder appropriate for your language.

4. Drag the Express User’s Guide onto your Macintosh’s 
hard drive.

5. Double-click the Express User’s Guide to open it.

Note: You will need Adobe Acrobat Reader installed to open 
the guide. If you do not have it, you can download and install 
Using Your Drive 17

feature, you can:

• Automatically make copies of your most important files.

• Make copies of your data onto other popular storage devices, 
including CD-R, DVD-R, and selected tape drives.

it for free from Adobe’s website: http://www.adobe.com

Restoring Files

It is easy to restore files that have been backed up using the Maxtor 
OneTouch feature. 
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To restore files:

1. Select the drive containing the copy of your files.

2. Open the Retrospect Backup folder and then the folder 
that contains your backup copy.

The folder is named ‘Backup copy of your_disk_name’ 
(Only the first 9 characters of this name will be used).

3. Drag the file or group of files you wish to restore to the 
desired folder as you would to move or copy any 
other file.

If you are not sure where the files you want to restore are 
located, use your operating system’s Find command to search 
the drive containing the backup data.

Changing Your Maxtor OneTouch Script

1. Open Retrospect Express. 

The Retrospect Express Directory window will open.

2. Click the Automate tab.

The Scripted Retrospect operations window 
will appear.

3. Click Scripts.

6. Click OK.

7. Quit Retrospect Express by going to the File menu and 
selecting Quit.

8. Push the button on the front of the drive.

The Maxtor OneTouch setup wizard will start. 
For OS X: See “To set up the Maxtor OneTouch button 
feature” on page 7 in chapter 2. For OS 9: See “To set 
up the Maxtor OneTouch button feature” on page 11 in 
chapter 2.

Adding Maxtor OneTouch Advanced Features

You can further customize your Maxtor OneTouch script with 
advanced features from Retrospect Express. To learn more 
about these advanced features, use the Express User’s Guide 
in the Retrospect Express Folder on your Macintosh. If is not 
installed on your computer, you can access it on the Maxtor 
installation CD. 

Using the Maxtor OneTouch Utility
Your Maxtor OneTouch drive includes a utility that allows you to:

• Find out more information about your drive 

• Customize your OneTouch button to launch a different 
application or file.
18

The Scripts window will appear.

4. Select the Maxtor OneTouch script. 

5. Press the Delete key on your keyboard.

A window appears asking: ‘Really forget Script?’

Drive Information: 

1. Open the Applications folder on your Macintosh hard 
drive and double-click the Maxtor OneTouch Settings 
icon to open it. 
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The Maxtor OneTouch Settings window should 
appear.

2. In the lower part of the window, you should see your 
OneTouch Drive listed and any other compatible Maxtor 
Drives currently connected and turned on.

Here you can find out useful information, including:

• Model

• Serial Number

• Application to be opened by the OneTouch button

Customizing your OneTouch button:

Launching a different application or file
You can launch most any application or file on your computer with 
the OneTouch button. For example, you could use it to launch a 
program like QuickTime or even a specific QuickTime file.

1. Go to your Applications folder on your Macintosh Hard 
Drive.

2. Double-click the Maxtor OneTouch Settings icon to 
open it. 

The Maxtor OneTouch Settings window should appear.

3. In the lower part of the screen you should see 
‘Volumes,’ ‘Maxtor OneTouch Drives’ and ‘Open. . .’

button on your OneTouch drive. It’s very simple to select 
a different program or file.

4. Make sure your drive is selected in this window and click 
Select Action. 

A window will open where you can find and select the 
application or file on your system.

5. Find the application or file that you would like to open. 
You’ll most likely need to navigate to your Applications 
folder to do this. Once you’ve found it, go to the next 
step.

6. Select your application or file and click Open.

7. Close the Maxtor OneTouch Settings utility.

8. Now, try out your new settings by pressing the button on 
your OneTouch drive.

The new application or file that you selected 
should open.

If your selected application does not function properly with 
the OneTouch button using the steps outlined above, it may 
not be compatible or supported with the OneTouch feature. 
Double-check that you are selecting the correct file by 
opening it manually. If the application still does not open, 
contact the publisher of the application to find out if you are 
launching the correct file.

This file should open every time you push the button on your 
Using Your Drive 19

Your Maxtor OneTouch drive should appear in this area. 
If you have multiple OneTouch drives you will be able to 
select each one separately. 

In the ‘Open...’ section of the screen, you should see the 
Retrospect icon and the words: Maxtor OneTouch. This 
is what is currently set to open when you press the 

OneTouch drive. 
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How to reset the OneTouch button:

If you ever want to set your button back to launch your 
OneTouch script, it’s very easy.

1. Open the Maxtor OneTouch Settings utility.

Once it opens, you should see your drive listed in the 
lower part of this window. 

2. Make sure your OneTouch drive is selected.

3. Click the Default Settings button.

This sets the button back to it’s original settings

4. Close the Maxtor OneTouch Settings utility.

Using Power Management

To minimize the power consumption of your drive while your 
computer is on, you can take advantage of the power management 
feature supported with the Energy Saver control panel on 
your Macintosh.

The power management feature sets the drive to automatically use 
less power after a predetermined period of time of inactivity. This is 
sometimes referred to as spin down since the drive’s internal 
mechanical disks stop spinning. When the drive is in the spin down 
mode, one of the blue power lights will remain on and the other 

Power Management Settings

OS 9

1. Under the Apple menu, select Control Panels.

The Control Panels folder will open.

2. Find and open the Energy Saver control panel.

The Energy Saver window will open, and the 
Sleep Setup settings should be displayed.

3. Make sure the checkbox for ‘Separate timing for hard 
disk sleep’ is checked.

The slider at the bottom of the screen controls the time 
period of inactivity before the all system hard drives will 
go to sleep. It is possible to choose as short as 10 
minutes and as long as 60 minutes. You can also set it to 
never go to sleep.

4. Select a time period using the slider in the bottom of the 
window.

5. Close the Energy Saver control panel.

OS X

1. Under the Apple menu, select System Preferences.

The System Preferences window will open.
20

one will blink.
2. Click the Energy Saver icon (a light bulb).

The Energy Saver panel will open, and the 
Sleep settings should be displayed.

3. Make sure the checkbox for ‘Put the hard disk to
sleep when possible’ is checked.
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The top setting, ‘Put the computer to sleep when it is 
inactive for,’ controls the time period of inactivity before 
the computer and it’s hard drives will go to sleep. It is 
possible to choose as short as 1 minute and as long as 
60 minutes. You can also set it to never go to sleep.

4. Select a time period using the top slider in the window.

5. Close the Energy Saver control panel.

Installing Applications on Your Drive
You may install and run applications from your OneTouch drive like 
any other drive on your system. 

Some Macintosh-based applications installed on your drive 
will only run on the computer where the application was 
installed. If you move your drive to any other computer, the 
application may no longer function. Once the drive is 
reconnected to the computer where the application was 
originally installed, the application will function properly.

Moving Data Between Two Systems
Your Maxtor OneTouch drive provides a great tool for moving large 
amounts of data between two systems. For more information see 
the Maxtor online knowledgebase: http://www.maxtorkb.com

Playing Games
CD-ROM-based games typically run faster when they are installed 
on a hard drive rather than running them from the CD. You can use 
your OneTouch drive to store and play CD-ROM games. See 
“Customizing your OneTouch button:” on page 19 for more 
information.

To install a CD-ROM game

1. Start the install program on your game CD.

2. Select Maximum Install (if supported), if you are
asked how to install the game on your system.

This option installs most or all of the game’s software
onto your drive. 

3. When asked for the location to install the software, 
specify an existing folder or create a new folder on
your drive.

Storing Audio 
Using your computer as an audio jukebox is a very popular 
application. This allows you to store and play thousands of your 
favorite songs. You can also create and manage an audio library on 
your OneTouch drive. A popular web site to learn more about these 
audio applications is at http://www.mp3.com. 

To use your drive to store your audio library, you need to specify a 
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folder on the drive as the default location for audio files in your 
audio jukebox software.
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Adding Rubber Feet to Your 
OneTouch Drive
If you plan to use your drive on a desk surface, your kit includes four 
rubber feet to protect your drive and the surface of your desk.

To apply the feet:

1. Make sure your drive is disconnected properly from your 
computer. (See “Connecting and Disconnecting the Drive” 
on page 15).

2. Make sure your drive is turned off, by turning off the power 
switch on the back of the drive.

3. Turn your drive so that the ridges are facing up. 
This is the bottom of the drive.

4. Place two rubber feet on each ridge on the bottom of your 
drive. One should be placed near the front and the other 
toward the back of each ridge.

Using Security Lock
Your new drive includes a security locking slot on the back of the drive. 
The security locking slot is compatible with most security locking 
cables, including those offered by Kensington.

Rubber Feet 
Placement

Bottom of Drive
22
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Backing Up Your System

One valuable use of your new Maxtor OneTouch drive is to backup 
your complete system. By using Retrospect Express, you can 
backup everything and restore your complete system, if you ever 
need to.2

What’s contained in a full system backup?

• Your current operating system

• Your applications

• Your personal files

• Your computer’s settings

In the following section, you’ll learn how to create a script to back 
up your complete system and you’ll do your first backup. A script is 
simply a set of instructions that will tells Retrospect Express what 
files you want to copy, where you want to put them and when 
you’d like the copying to take place. In Chapter 6, we show you 
how to restore all the files on your system in the event that your 

2

according to the steps described in this chapter. If you need to 
restore data to a different computer and / or a different operating 
system, this product will only support the restoration of user files 
and does not support under those circumstances restoration of the 
Operating System, drivers, applications or settings.

Before you begin. . .
In order for your system backup to be successful, you need to 
know how big your complete system is and if your backup drive 
has enough capacity to store all your files. 

In the following steps, you will determine how big each drive on 
your system is. This is important information to have, not only to 
back up your system, but also in case you ever need to restore your 
system. We encourage you to write down this information and 
keep it in a safe place, just in case.

To determine how big your system is:

1. Starting from the desktop, you should be able to see each 

4
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system is damaged or completely erased.___________
2      The Maxtor OneTouch drive, in combination with the included Dantz 

Retrospect software, supports a complete system restore capability 
(Operating System, drivers, applications, settings and user files) back 
to the original computer system (running the same operating 
system) that the backup copy was made from, when performed 

drive’s icon.

You will view information on each drive individually and then 
add them up.

2. Select a drive’s icon.
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3. In OS X: Go to the File menu and select Get Info (OS X 10.2) or 
Show Info (OS X 10.1).

In OS 9: Go to the File menu and select Get Info,

then Information.

4. The Info window will open.

In this window you will be able to see the Capacity of the
drive, as well as the amount of space Used on the drive. Make
a note of the Capacity number and close the window.

5. Repeat steps 1 - 4 for each drive on your Macintosh.

6. Add up the Capacity numbers for all of your drives.

This is how much total space is needed to backup your complete 
system, if it were full.

7. Use this number as a guide to figure out how much space you 
will need on your backup drive to store your complete system. Figure 8.  Drive information: Macintosh OS 9
24
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Backing up your complete system

You cannot run Retrospect Express under OS 9 to create 
system backups of OS X. You must run Retrospect Express 
under OS X to back up an OS X system.

1. Open Retrospect Express

The Retrospect Express Directory window will open.

2. Click the Automate tab.

The Scripted Retrospect operations section will appear.

3. Click EasyScript. 

The ‘Welcome to EasyScript’ window will appear.

4. Click Next.

The Backup media page will appear.

5. Select File backup set (hard disk) and click Next.

The Backup frequency page appears asking you:
‘How often do you want to back up?’

6. Choose either Every day or Once a week

If you chose the once a week backup option, choose the 

9. Click Create.

A window appears asking you: ‘What do you want to name 
your backup set?’

10. Type in a memorable name, like System Backup, and click New. 

The Choose a Folder window will now appear.

11. Select the drive you plan to back up to (your Maxtor OneTouch 
drive) and click Save. 

A window will appear, telling you: ‘EasyScript has created and 
scheduled a script’

At this point, you can click Open Script to view your script and 
make changes, or you can simply click Done to finish. You’ll 
learn how to make basic changes to your script later in this 
chapter.

12. Click Done.

You now have a finished script that will automatically backup your 
system at the time and date you specified. All you have to do is 
leave your computer and Maxtor OneTouch drive on. You don’t even 
have to open Retrospect Express!

We highly recommend that you run your backup script manually the 
first time to make sure that it backs up everything you need. You’ll 
learn how to do this in the following section.
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Day also.

7. Click Next.

The EasyScript backup strategy window appears.

8. Choose a start time for your backups.

Doing your first backup: testing your script

1. Open Retrospect Express (if not already open).

The Retrospect Express Directory window will open.

2. Click on the Run drop-down menu at the top of the screen and 
pull down to select EasyScript Backup. 
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The EasyScript Backup window will appear.

3. Make sure Execute now is selected and click Execute. 

Retrospect will now start scanning your system, the 
Immediate Backup window will open and the backup process 
will begin. 

Normal backup may take a long time, the first time. Each 
time after that, it will take less time. This is because 
Retrospect compares the files in your actual system to the 
backup version and only copies new files or files that have 
been modified since the last backup. For more information 
on backup strategies, see the Express User’s Guide.

When the backup is complete, the message: ‘Execution 
completed successfully’ should appear.

If your system backup was successful, you can quit Retrospect.

4. OS 9: Go to the File menu and select Quit.

OS X: Go to the Retrospect Express menu and select Quit 

Retrospect Express.

When you quit Retrospect, a window will appear telling you: 
‘Script EasyScript Backup is next for automatic execution.’

If you get the message that ‘the configuration isn’t ready,’ 
click Don’t Quit, make sure that your OneTouch drive is 
connected and turned on and quit Retrospect again. 

5. Click Quit.

Congratulations. You’ve now done your first system backup!

See “Disaster Recovery” on page 28 in chapter 5,” for guidelines 
on how to restore your system using the system backup you just 
created, in the event that you need to.

Making changes to your backup script

If you decide you want to change your backup script, follow 
these steps:

To change the time of your backup:

1. Open Retrospect Express.

The Retrospect Express Directory window will appear.

2. Click the Automate tab.

The Scripted Retrospect operations section will appear.

3. Click Scripts.
26

This is a reminder to make sure that the drive you plan to use for 
the next backup (your OneTouch drive) is connected to your 
computer and ready. If you are not sure, you can click the Check 

Media button to have Retrospect check for you. 

The Scripts window will appear.

4. Select your script. It will be labelled EasyScript Backup.

5. Click Edit.
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The EasyScript Backup window will appear, showing the details 
of your backup script. 

In this window you can modify many aspects of your 
backup, including which drives you will back up and the 
backup destination. For more information, see the 
Retrospect Express User’s Guide that came with your 
Maxtor drive.

6. Make any changes to your script needed.

7. Close the EasyScript Backup window.

A message will appear asking: ‘Save changes to script?’

8. Click Save.

9. If the Scripts window is still open, close it.

10. Quit Retrospect.

When you quit Retrospect, a window will appear telling you: 
‘Script EasyScript Backup is next for automatic execution.’

If you get the message that ‘the configuration isn’t ready,’ 
click Don’t Quit, make sure that your OneTouch drive is 
connected and turned on and quit Retrospect again. If this 
still doesn’t work, try creating a new EasyScript.
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Your modified script has been saved and will run at the next 
scheduled time as long as your computer is on and your Maxtor 
OneTouch drive is connected and turned on.
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Disaster Recovery

If disaster has struck and your system software is damaged or 
completely erased, this chapter provides you with step-by-step 
instructions on how to restore your system.3

These steps will be successful ONLY if you have backed up your 
system using Retropsect and the steps outlined in the previous 
chapter. 

What’s contained in a full system restore?

• Your current operating system

• Your applications

• Your personal files

• Your system’s settings and updates

Before you begin. . .
Because of factors like processor type, motherboard, video display 

3     The OneTouch drive, in combination with the included Dantz 
Retrospect software, supports a complete system restore capability 
(Operating System, drivers, applications, settings and user files) back 
to the original computer system (running the same operating 
system) that the backup copy was made from, when performed 
according to the steps described in this chapter. If you need to 
restore data to a different computer and / or a different operating 
system, this product will only support the restoration of user files 
and does not support under those circumstances restoration of the 
Operating System, drivers, applications or settings.

Basic Guidelines

For your system restore to be successful, we recommend that you 
restore your system only: 

• To the same computer and same internal drive

• To the same computer and new internal drive

If you cannot restore to your original computer or an identical 
system, you can restore all of your personal files to a different 
computer. For more information see http://www.maxtorkb.com.

5
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card and other hardware that is specific to your brand and model of 
computer, we urge you to ONLY do a full system restore to the 
same computer. Restoring your operating system, its applications 
and settings to another computer with different hardware is not 
supported and may cause significant problems with that computer.

_________________________________________
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Restoring your complete system

Before you begin, you must format your system hard drive and 
install your operating system. If you had multiple partitions on your 
hard drive(s), you must create and format the same number of disk 
partitions. These partitions must be of equal or greater size to what 
they were on your original system. For information on how to 
partition and format your system drive, see the Maxtor 
Knowledgebase online at: http://www.maxtorkb.com.

Most Macintosh computers are setup at the factory with 
only one partition per hard drive. If you did not have multiple 
partitions on any of your hard drives, all you have to do is 
reformat your hard disk(s) and re-install your Macintosh 
operating system. For more information, see your 
Macintosh manual.

Do not partition or reformat the Maxtor OneTouch drive that 
your system backup is stored on.

Once you get your system running, reinstall Retrospect Express 
using the Maxtor Install CD. See “Installing Your Drive” on page 5 
in chapter 2. 

Restoring your system - Step-by-step

1. Prepare your hard dive - (Partition, if necessary, and format.)

5. Click Restore. 

A window will appear asking you to ‘Select the restore type’ 

6. Select Restore an entire disk and click OK.

The ‘Accessing more backup sets’ window will appear asking 
you to open an existing catalog file or rebuild one.

7. Click Open.

Find and select the system backup set on your Maxtor 
OneTouch Drive.

8. Click Open. 

Your system backup set should appear in the top part of the 
Restore from Backup:Source window. Make sure it 
is selected.

9. Click OK.

The Destination Selection window will now appear, asking 
you to choose a ‘Destination for restore.’

Make sure Restore Entire Disk is selected. and select the 
drive that you want to restore your system to (your Macintosh 
hard drive where the system was originally installed).

10. Click OK.
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2. Install your operating system. 

3. Reinstall Maxtor OneTouch software including Retrospect 
Express. (For more information see page 5 in chapter 2.)

4. Open Retrospect Express.

The Retrospect Express Directory window will open.

A window will appear asking you if you really want to restore to 
the drive you selected, replacing it’s entire contents.

11. Click Replace.

Retrospect will scan your system (This may take a 
few minutes).
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The Restore from Backup window will appear, allowing you to 
confirm the source (your OneTouch drive) and the destination 
(your Macintosh hard drive) for the restore.

12. Click Restore.

A window will appear asking you: ‘Really Execute?’

13. Click OK.

(If the ‘Really Execute?’ window appears again, click OK.)

Retrospect will begin to restore your system.

This process may take several minutes.

When Retrospect finishes, you should see the message: 
‘Execution completed successfully.’

You can view the Log to make sure that all of your files were 
restored by going to the Window menu and selecting Log.

14. Quit Retrospect. OS 9: Go to the File menu and select Quit. 
OS X: Go to the Retrospect Express menu and select Quit 
Retrospect Express.

15. Restart your Macintosh.

If the system restore was successful, you should find all of the files 
that you originally backed up. If not, make sure that you understand 
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how to back up your system. See “Backing Up Your System” on 
page 23 in chapter 4. By scheduling automated backups, you’re 
less likely to lose your valuable files in the future.
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Troubleshooting and FAQs

This chapter provides troubleshooting tips and answers frequently 
asked questions about installing your Maxtor OneTouch drive.

You can find additional information in the Maxtor Knowledge Base 
at www.maxtorkb.com or contact Maxtor at www.maxtor.com.

Chapter Contents

General Troubleshooting
1. Drive does not appear on my system 33
2. My drive appears to read files significantly faster than it writes files 34
3. My drive shows less capacity than on the box label 35
4. Maxtor OneTouch function does not work 35
5. My drive is not copying or backing up a network drive 35
6. What does partitioning a drive mean? 35
7. How do I partition a drive? 36

Application Troubleshooting
8. Applications installed on the drive stopped running 36
9. My computer drops frames when I capture video from my 36

Canon camcorder

General Troubleshooting

1. Drive does not appear on my system

• Is the drive running?

The two blue lights on the front of the drive should be 
illuminated, and you should be able to feel the hum of the drive 
when you place your hand on it. In addition, the light on the 
power adapter should be lit.

Make sure the power adaptor is securely plugged into the drive 
and into a power outlet. If the drive is plugged into a power 
strip, try plugging it directly into the wall outlet, in case the 
power strip is not working properly.

• Is the FireWire cable connected properly?

Verify that the cables are connected according to the installation 
instructions of “Installing Your Drive” on page 5 of chapter 2.

• Have you tried turning off your drive and turning it back on?

a. While your computer is running, unplug the FireWire cable 
from the drive, then turn off the drive.

6

Troubleshooting and FAQs 33

b. Wait ten seconds, then turn the drive back on.

c. Wait another ten seconds, and plug the FireWire cable in. 
See if the drive appears on your desktop.
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If the drive does not appear on your desktop, try the tips in the 
next section for your computer’s specific operating system. If 
the drive still does not appear on your system, visit the Product 
Support area of the Maxtor web site at www.maxtorkb.com for 
further assistance.

Do you have the most current Maxtor software?

Check the Product Support area at: www.maxtorsupport.com 
to determine the latest version.

Are AppleTalk and File Sharing off? If not, turn them off and 
reboot. If, after rebooting, the drive still does not mount, try 
turning the drive off and back on again. 

Follow these steps to open the Apple System Profiler.

For OS X:

• Go to the Apple Menu and select About This Mac.

The About this Mac screen will appear.

• Click the More Info button. The Apple System 
Profiler will open. 

• Click the Devices and Volumes tab.

• Depending on which Maxtor hard drive you are 
using, your Maxtor drive should appear as a
rectangle in the FireWire Information 
section of the screen. 

For OS 9:

• Go to the Apple Menu and select Apple System 
Profiler. The Apple System Profiler will open. 

• Click the More Info button. The Apple System 
Profiler will open. 

• Click the Devices and Volumes tab.

• Depending on which Maxtor hard drive you are 
using, your Maxtor drive should appear as a
rectangle in the FireWire section 
of the screen. 

• Clicking any of the horizontal triangles next to the 
different rectangles on this screen, shows more 
detailed information about the device, including 
the manufacturer. 

• If you can’t find your Maxtor drive, try turning the 
drive off, waiting 10 seconds and turning it back on.

If your drive does not appear after trying all of the suggestions 
above, visit the Product Support area at: 
www.maxtorsupport.com.

2. My drive appears to read files significantly faster 
than it writes files

Your drive includes a special data protection function, which 
34

• Clicking any of the horizontal triangles next to the 
different rectangles on this screen, shows more 
detailed information about the device, including 
the manufacturer. 

If you can’t find your Maxtor drive, try turning the 
drive off, waiting 10 seconds and turning it back on.

automatically verifies all data written to the drive during the first 
few uses of the product. It’s similar to the break-in period for a 
new car. The verification process is performed while data is 
being written, causing reduced write performance. 

This verification function is automatically turned off after your 
drive has been powered on and off ten times (you need to leave 
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the drive running for 15 seconds before powering it off and 
leave it off for 15 seconds before powering on again). After this 
break-in period, you should see approximately the same 
performance for reading and writing data.

3. My drive shows less capacity than on the box label

Hard drive capacity is defined in terms of decimal (base 10) 
capacity. In decimal notation, one megabyte (MB) is equal to 
one million bytes and one gigabyte (GB) is equal to one billion 
bytes. We are most accustomed to the decimal system in 
everyday life. However, computers use the binary (base 2) 
numbering system. In the binary numbering system, one 
megabyte is equal to 1,048,576 bytes, and one gigabyte is 
equal to 1,073,741,824 bytes. 

The Mac OS uses the binary numbering system. When you use 
your system to check your drive’s capacity, multiply the value 
shown (displayed in base 2 megabytes) by 1,048,576 to 
determine the decimal equivalent for the hard drive's capacity.

Here is how to access hard drive capacity on your Macintosh:

• Go to your desktop and select the external hard drive.

• For OS X or later, choose File>Get Info. 

• For OS 9, choose File>Get Info>General Information

4. Maxtor OneTouch function does not work

• Press the Maxtor OneTouch button again. Retrospect
Express should open and your backup copy should begin

The OneTouch backup copy will not run if the Retrospect 
software cannot locate either the source drive or the 
destination drive. To check this problem:

• Start Retrospect Express. 

• Click the Automate tab at the top of the screen.

• Click the Scripts button. 

• You should find a script called Maxtor OneTouch. This 
script defines what exactly will be backed up

If you do not see this file, follow the instructions in the “Setting 
Up the Maxtor OneTouch Feature” in chapter 2.

• Select the Maxtor OneTouch entry and then click the Edit 
button.

Confirm that both the source and destination drives (volumes) 
are specified and are currently running on your system. 

If you rename either the source or the destination drives after 
you create the script, the backup will not work.

5. My drive is not copying or backing up 
a network drive

Your Maxtor OneTouch drive and Retrospect Express software 
Troubleshooting and FAQs 35

Here are a few items you can quickly check if your Maxtor 
OneTouch feature does not operate.

The Maxtor OneTouch button may not function when 
Retrospect Express is already running. To correct the problem:

• From the File menu, select Quit. 

are not supported for the purpose of copying or making backup 
copies of network drives available from your computer. 

6. What does partitioning a drive mean?

Partitioning is a way of dividing up your hard drive into different 
sections which appear as separate drive icons in the Macintosh 
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OS. Partitioning helps you to manage files more easily. One 
common use of partitioning is to install your operating system in 
one partition and all of your applications in another. 

7. How do I partition my drive?

There are a number of excellent programs for partitioning. For 
more information on the appropriate one for your operating 
system see the Maxtor Knowledge Base at:
http://www.maxtorkb.com

Application Troubleshooting

8. Applications installed on the drive stopped running

See “Installing Applications on Your Drive” on page 21 of chapter 
3, for an explanation of possible reasons for and solutions to this 
problem.

9. My computer drops frames when I capture video from 
my Canon camcorder

Some models of Canon camcorders produced in 1998 and 1999 
have trouble transferring DV data over the 1394 interface. For the 
latest information and a solution for this problem, search the 
Maxtor Knowledge Base at www.maxtorkb.com with the key 
word “Canon.”
36
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Glossary

Byte – A unit of storage on a drive that holds a single character. 
A byte is equal to 8 bits.

Capacity – The amount of information, measured in bytes, that 
can be stored on a drive. Also known as storage capacity.

Daisy chain – A hardware configuration in which peripheral 
devices are connected to each other in a series. The FireWire 
interface, for example, supports a daisy chain of up to 62 drives. 

Data Transfer Rate – The speed at which data transfers to 
and from the drive.

External Hard Drive – A external peripheral device containing 
a hard drive mechanism connected to a computer via a FireWire 
or USB interface.

FireWire – The FireWire interface is a high-performance, serial 
bus defined by the Institute of Electrical and Electronics 
Engineers (IEEE) as a standard for connecting digital devices 
together. It is ideal for connecting computers and hard drives to 
digital video and audio equipment.

GB – (Gigabyte) Equal to 1,000,000,000 (billion) bytes. For a 
detailed explanation, refer to page 29.

Hard Drive  – An electromechanical device used for 
information storage and retrieval, incorporating one or more 
rotating disks on which data is recorded, stored, and read 
magnetically. 

Hot-Swap – This feature allows you to connect and disconnect 
external devices while the computer and the devices are running. 
External drives, such as the Maxtor Personal Storage 5000 can 
be hot-swapped.

KB – (Kilobyte) Equal to 1,000 (thousand) bytes.

MB – (Megabyte) Equal to 1,000,000 (million) bytes.

Mb – (Megabit) When used to describe data storage, equal to 
one million bits. 

Mbps – (Megabits per second) When used to described data 
transfer rates, it refers to one million bits per second.
Glossary 37

Format – Formatting erases all information on a hard drive and 
sets up the file system for storing and retrieving files. On 
Macintosh systems, high-level formatting is often referred to as 
initialization. Low-level formatting sets up the locations of sectors 
on the drive. Your drive was formatted with the FAT32 file system 
at the factory.

Operating System – Software that allows the user and 
programs installed on your system to communicate with 
computer hardware such as a hard drive and processor.

Partition – A way to logically divide a hard drive so that an 
operating system treats each partition as if it were a separate 
hard drive. Each partition is assigned a unique drive icon. 
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Port – A connection or socket on the motherboard, controller 
card, case, or chassis for connecting peripheral devices, such as 
a FireWire socket. 

Script – A saved backup procedure for Retrospect that you can 
schedule to run at some future date and time or on a repeating 
schedule, such as daily. You may create as many scripts as you 
wish.

Spin Down – Refers to the actually spinning of the disk 
mechanism. When a disk spins down, it stops spinning, thus 
conserving power.

Startup Disk – The drive from which the operating system 
loads to start up your computer.

TB – (Terabyte) Equal to 1,000,000,000,000 (trillion) bytes. 

Volume  – A fixed amount of storage on a hard drive. The term 
volume is often used as a synonym for the drive itself, but it is 
possible for a single drive to contain more than one volume or for 
a volume to span more than one drive.
38
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